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Statement 

Thank you for choosing PIXELHUE products. This document is intended to help you understand and use 
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1.1 About This Manual  

This user manual guides you how to use our product. This manual is designed to be a 
reference for your daily use of our product. 

 Note  

Always check for the latest version of all documents at www.pixelhue.com.  

1.2 Version History  

Version Date Description 

V1.2.0 2023-03-15  Updated some hardware descriptions. 

 Updated some software pictures and descriptions. 

V1.1.0 2022-11-9  Updated the device rear panel picture. 

 Updated the 4K input card and 2K output card pictures 
and descriptions. 

 Updated the descriptions and user interface pictures 
of the built-in software Pilot MS3. 

V1.0.0 2022-5-30 First release 

1.3 Symbols and Pictures  

Symbol Overview 

  Danger Indicates a hazard with a high level of risk, which if not 
avoided, will result in death or serious injury. 

  Warning Indicates a hazard with a medium or low level of risk, which if 
not avoided, could result in minor or moderate injury. 

  Caution Indicates a potentially hazardous situation, which if not 
avoided, could result in equipment damage, data loss, 
performance degradation, or unexpected results. 

  
Note Provides additional information to emphasize or supplement 

important points of the main text. 

Picture Overview 

Images and pictures given in this manual are used for illustration purposes only. The 
actual product may vary due to product enhancement. The content of the images can 
be slightly different from reality, such as device types, installed modules, form and 
position of software windows on the screen. 

http://www.pixelhue.com/
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2 Safety 

Overview 

 General Considerations 

 Device Carrying 

 Device Mounting 

 Cable Requirements 

 Electrical Safety 

 Unpacking and Inspection 

 Device Labels 

 Notes and Cautions 
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2.1 General Considerations 

To ensure that you can use this product correctly and safely, please be sure to 
observe the following precautions: 

 Before performing any operation, make sure that you have read all the operating 
instructions provided by the device, especially the instructions that may endanger 
the personal safety and device safety, such as dangers, warnings and cautions, to 
minimize the probability of accidents. 

 All the operations must conform to local safety codes. When the safety and 
precautionary measures described in this manual conflict with local safety codes, 
please follow the local codes. 

 The personnel responsible for installing and maintaining the device must be 
professionals who have been trained and have mastered the correct operation 
methods and all safety precautions. Only trained and qualified personnel can 
perform device installation and maintenance. 

 This device must be used in an environment that meets the design specifications; 
otherwise, it may cause device failure. The resulting device function abnormalities 
or component damage, personal safety accidents, property losses and other 
situations are not included within the scope of the device warranty. 

2.1.1 General Safety 

 When operating the device, you must strictly abide by the local laws and 
regulations. The safety precautions described in this manual are only a 
supplement to the local safety laws and regulations. 

 The "Danger", "Warning" and "Caution" items described in this manual are only 
supplementary instructions for all safety precautions. 

 To ensure personal and device safety, please strictly follow all the safety 
precautions on the device labels and described in this manual when installing the 
device. 

2.1.2 Environmental Requirements 

 Ensure adequate air flow in the equipment room. 

 Take necessary measures to prevent dust, water and static electricity. 

 Avoid long-term direct sunlight. 

 Keep the device away from heat and ignition sources. 

 Do not place the device in an explosive atmosphere. 

 Do not place the device in a corrosive environment. 

 Do not place the device in a strong electromagnetic environment. 
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The following table outlines the physical environment where the device can be safely 
stored and operated. 

Environmental 
Requirements 

Operating Environment Storage Environment 

Temperature 0°C to 45°C –20°C to +70°C 

Humidity 0% RH to 80% RH,  

non-condensing 

0% RH to 95% RH,  

non-condensing 

Air Cleanliness ISO 14644-1 ISO 9  N/A 

2.1.3 Device Safety 

 Before operating, fix the device on the floor or other stable objects, such as a wall 
or mounting bracket. 

 During transportation and use of the device and its packaging, the device must be 
fixed stably to avoid falling. 

 Do not step on, hit and violently operate the device and its packaging to prevent 
damage to the device or packaging box. 

 Do not block the ventilation openings during operation.  

 Tighten the board or card screws with a tool. 

 After the installation, remove the empty packing materials from the device area. 

 Save the packing box and materials for possible storage and transportation in the 
future.  

 Always wear anti-static wrist bands and insulating gloves when touching the 
static-sensitive components. 

 Avoid dropping any object into the chassis. 

 Keep the device away from conductors that are easy to induce lightning to avoid 
lightning strikes to the device. 

 Do not make the circuit faces of the boards or cards contact each other. 

 Do not touch the circuit, components, connectors or wiring slots of the boards or 
cards with bare hands. 

 Do not repair the device without authorization. Only trained professionals can 
maintain the device. You can contact Pixelhue at any time if needed. 

 Always use the spare parts recommended by Pixelhue. 

 Regularly clean the dust on the heat dissipation holes to prevent the dust from 
blocking the holes and thus affect the heat dissipation of the device. 

2.1.4 Personal Safety 

 Place the device in a stable location to prevent personal injury caused by falling. 

 Avoid bare wires and maintain or replace them in time when they are damaged. 

 Do not operate the device and connect cables outdoors under thunderstorms. 

 Do not wear watches, rings, or other metal jewelry when installing spare parts or 
maintaining the device. 
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2.2 Device Carrying 

 Do not relocate a powered device, and do not take any objects that may cause 
danger to the relocation. 

 Always pay attention to the wheels at the bottom of the flight case during 
transportation to avoid them being jammed by stones or deformed due to external 
forces. 

 Always hold the handles of the flight case firmly when pushing a flight case with 
wheels. Do not stack other devices on the flight case. 

 The relocated device should be repacked in the original factory packaging. 

 When handling or placing the boards or cards, bare board components or 
modules, always package them individually. 

 When carrying the device with your bare hands, always wear protective gloves to 
avoid injury. 

 When carrying the device, handle it gently and always hold the handles of the 
device or drag the bottom edge of the device. Do not hold the handles of a device 
component. 

 When the device weight exceeds the carrying limit of a single person, carry it with 
multiple people or use a carrying tool. 

 When using a forklift or handcart for transportation, place the device stably to 
ensure the device will not tip over. 

The following table lists the maximum weights that adults can carry at a time 
specified by some organizations for your reference. 

Organization Weight 

CEN (European Committee for Standardization) 25 kg/55.13 lb 

ISO (International Organization for Standardization) 25 kg/55.13 lb 

NIOSH (National Institute for Occupational Safety and Health) 23 kg/50.72 lb 

HSE (Health and Safety Executive) 25 kg/55.13 lb 

General Administration of Quality Supervision, Inspection and 
Quarantine of the People’s Republic of China  

Male: 15 kg/33.08 lb 

Female: 10 kg/22.05 lb 

2.3 Device Mounting 

When the device is installed on a desktop or into a rack, the desktop or rack must 
bear at least 4 times the device weight. 

2.3.1 Mounting on a Desktop 

 Ensure the stability and grounding of the desktop or working table. 

 Ensure that the device is placed horizontally and do not turn it over or hang it on 
the wall. 

 Do not place other objects on the device. 
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 Do not put water cups, beverages and other containers with liquid close to or on 
the device to avoid liquid leakage and thus cause safety hazards. 

 If any object or liquid accidentally enters the device, stop using the device and 
disconnect the power cord and all cables connected to the device immediately, 
and then contact the after-sales personnel. 

 When handling a flight case with wheels, please lock and fix the wheels to prevent 
the device from sliding. 

 When stacking, ensure all the devices are stacked stably to avoid device damage 
and personal injury caused by falling.  

2.3.2 Mounting into a Rack 

 The rack must be fixed properly to avoid tilting and falling, and thus cause 
personal injury and device damage. 

 When a device is mounted into a rack, all mounting holes must be fixed with 
screws. 

 Ensure the rack is well ventilated. It is recommended to reserve at least 1U space 
between the stacking devices, and the heat dissipation vents must not be 
obstructed and keep at least 10 cm distance from other objects. 

2.3.3 Grounding 

 Connect the grounding wire first when installing a device, and disconnect the 
grounding wire at last when removing the device. 

 The connecting surface of the grounding wire and the device must have good 
conductivity. Spray painting is strictly prohibited, and there must be sufficient 
fastening force between the connecting parts. 

 Do not operate the device when the grounding conductor is not installed. 

 There must be no joints in the middle of the grounding wire, and it is strictly 
prohibited to install a switch or fuse on the grounding wire. 

 For devices using a three-pin socket, ensure that the ground terminal in the three-
pin socket is well grounded. 

2.4 Cable Requirements 

2.4.1 Power Cords 

 Warning  

Do not install or remove the power cord when the device is powered on. When the 
power cord core contacts the conductor, an electric arc or spark will be generated 
which may result in fire or eye injury.  

 Protect the power cord properly to prevent it from being punctured to avoid 
personal injury or fire caused by a short circuit. 

 To ensure the safety of the device and personnel, be sure to use the matched 
power cord. 
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 User-supplied cables must comply with local cable regulations and device cable 
requirements. 

 Before installing or removing the power cord, turn off the device power first. 

 Check the electrical plug regularly and wipe off the dirt or dust accumulated on 
the plug. 

 Before connecting the power cord, read the labels or markings on the power cord 
to make sure it is a matched one. 

The device is intended to operate from an AC power source with a voltage range of 
AC 100–240V~, 50/60Hz. Various standard plugs are shown in the figure below. 

US NEMA5/15 Europe CEE 7 China GB 2099 UK BS 1363 

    

E Earth   N Neutral   L Live 

2.4.2 Signal Cables 

 Before using a DVI signal cable, check whether the pins on the cable connector 
are vertical and even. If not, please replace the cable. 

 Before connecting the signal cable to the device, check whether there is any 
object in the device connector. If yes, remove the object first. 

 If the signal cable has not been used for a long time, discharge static electricity 
before using it. 

 Under normal working conditions of the device, it is recommended that non-
technical professionals do not perform hot-swapping to avoid device damage. 

2.4.3 Miscellaneous 

 Signal cables must be bound separately from strong current cables or high 
voltage cables. 

 When the temperature is too low, severe shock and vibration may cause brittle 
cracking of the plastic sheath of the cable. All cables should be laid and installed 
when the temperature is above zero. 

 If the storage temperature of the cable is below zero, the cable must be moved to 
room temperature and stored for more than 24 hours before laying and 
installation. 

 When carrying cables, especially in a low-temperature environment, always handle 
the cable with care. Violent handling, such as pushing down the cables directly 
from a high place, is prohibited. 
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2.5 Electrical Safety 

2.5.1 Battery 

 There is a danger of explosion if a battery is incorrectly replaced. Replace only 
with the same or equivalent type recommended by the manufacturer. 

 Always follow the relevant instructions to dispose of batteries. 

 Do not throw lithium batteries into fire. 

2.5.2 Electromagnetic Interference 

 Keep the device away from transformers, high-voltage power lines and high-
current devices. 

 Keep the device away from high-power broadcast transmitters. 

 If there is a mobile communication transmitter around the device, its interference 
degree should meet the requirements of relevant standards. If needed, take 
necessary measures to prevent interference, such as shielding and isolation. 

 When using hand-held wireless communication devices, such as interphones, 
keep at least 30 cm away from the device. 

2.5.3 Anti-Static 

 Always wear anti-static wrist bands and insulating gloves when touching the 
static-sensitive components. 

 Always hold the board by the edges to avoid touching the circuits or components, 
and do not touch the chip with your hands. 

 The disassembled board must be packaged with anti-static packaging material 
before storage or transportation. 

2.6 Unpacking and Inspection 

2.6.1 Unpacking 

 After receiving the device, check whether the packing box is damaged. If there is 
any damage, do not open the box and contact the carrier in time to confirm the 
damage to the device and matters related to compensation. 

 After unpacking, save the packing box and materials for possible storage and 
transportation in the future. 

2.6.2 Inspection 

 When the packing box is in perfect condition, unpack the box. Check the 
appearance of the device for damage. If there is damage, please contact the 
salesperson. 

 Check the box contents according to the packing list described in the certificate of 
approval. If any item is missing, please contact the salesperson in time. 
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2.7 Device Labels 

Labels Description 

 

Shock hazard 

  

Multiple power inputs 

The device is powered by multiple power supplies. 
Disconnect all power cords when the device is powered off. 

 

Warranty void if removed 

Do not open the chassis. If this label is damaged, the device 
will not be covered by the warranty. 

  

 

Grounding 

The two ends of the grounding wire are connected to the 
device and the grounding point respectively, which means 
that the device must be grounded through the grounding 
point to ensure the normal operation of the device and the 
personal safety of the operators. 

 

Sensitive electronic device 

Keep the device away from areas with strong 
electromagnetic radiation to avoid electromagnetic 
interference and thus affect the image output quality. 

 

Device carrying 

The device needs to be carried by multiple people. 

2.8 Notes and Cautions 

2.8.1 Notes for Battery 

 The battery is not intended to be replaced. 

 Disposal of a battery into fire or a hot oven, or mechanically crushing or cutting of 
a battery can result in an explosion. 

 Leaving a battery in an extremely high temperature surrounding environment can 
result in an explosion or the leakage of flammable liquid or gas. 

 A battery subjected to extremely low air pressure may result in an explosion or the 
leakage of flammable liquid or gas. 

2.8.2 Notes for Installation 

When the product needs to be installed on the rack, 8 screws at least M5*8 should be 
used to fix it. The rack for installation shall bear at least four times the total weight of 
the mounted equipment. 

a) Elevated Operating Ambient - If installed in a closed or multi-unit rack 
assembly, the operating ambient temperature of the rack environment may 
be greater than room ambient. Therefore, consideration should be given to 



X400 Professional Media Server User Manual 2 Safety 

 

www.pixelhue.com 11 
 

installing the equipment in an environment compatible with the maximum 
ambient temperature (Tma) specified by the manufacturer. 

b) Reduced Air Flow - Installation of the equipment in a rack should be such 
that the amount of air flow required for safe operation of the equipment is 
not compromised. 

c) Mechanical Loading - Mounting of the equipment in the rack should be such 
that a hazardous condition is not achieved due to uneven mechanical 
loading. 

d) Circuit Overloading - Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the 
circuits might have on overcurrent protection and supply wiring. Appropriate 
consideration of equipment nameplate ratings should be used when 
addressing this concern. 

e) Reliable Earthing - Reliable earthing of rack-mounted equipment should be 
maintained. Particular attention should be given to supply connections other 
than direct connections to the branch circuit (e.g. use of power strips). 

2.8.3 FCC Caution 

Any changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.  

This device complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense. 

2.8.4 Others 

 This is Class A product. In a domestic environment, this product may cause radio 
interference in which case the user may be required to take adequate measures. 

 This product can only be placed horizontally. Do not mount vertically or upside-
down. 

 Please read the manual thoroughly and use the product in accordance with the 
requirements. If you have any questions about the specifications, please contact 
us immediately. If you use the product improperly, not following the requirements, 
or for illegal purposes, you shall be solely responsible for any consequences 
arising therefrom. 
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3 Hardware Overview 

About This Chapter 

This chapter is designed to describe the hardware appearance, features and 
specifications of the X400 media server. 

Overview 

 Introduction 

 Features 

 Appearance  
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3.1 Introduction 

The X400 is PIXELHUE's brand-new professional media server specifically designed 
for various large-scale multimedia applications. The X400 adopts a modular and 
plug-in design, allowing users to flexibly choose the desired input and output cards to 
meet various connections needs. The X400 is equipped with a new generation of 
Intel processor, high-performance server-class motherboard, server-class graphics 
card, high-speed SSD and other excellent hardware features to ensure a highly 
smooth and stable on-site operation. 

The X400 has a built-in professional multimedia playback software Pilot MS3, 
allowing for the display and control 8K images in pixel-to-pixel mode or multiple 4K 
images simultaneously, and enabling users to freely unleash their stunning and 
creative mosaic ideas. Pilot MS3 features with an intuitive, easy-to-use and fully-
visualized graphical UI and provides complete functionalities required for media 
editing and broadcasting in professional stage performances, thus becoming the 
unrivaled choice for a large number of high-end rental and other creative display 
applications, such as stage performances, large-scale conferences, exhibitions,  
presentations and more. 

3.2 Features 

Software 

 Playback and real-time editing of all categories of media, including videos, 
pictures, audio, web pages, acquisition devices and NDI inputs 

 Various playback modes, including single program, single media, media collection, 
cross-program media and jump playback 

 Unlimited layers and unlimited programs 

 Powerful slices for diversified visual applications 

 Visualized management of slices, programs, playback and input sources 

 Flexible mosaic realizes your creative ideas 

 Auto preview and preview editing of next program 

 Media optimization for better media performance 

 Media image quality adjustment 

 Media mirroring, stretching, cropping supported 

 Crossfade and cut effects on program switching 

 Decoding of various mainstream video formats 

 Output mapping and markings for clear screen and connector correspondence 

 Automatic software startup and program playback 

 Project file management and packaging 

Hardware 

 8K or multiple 4K hardware decoding and rendering for smooth playback and 
flawless output 

 Plug-in and modular design for higher system stability 
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 Frame sync technology for synchronized and smooth display 

 Seamless primary and backup device switching safeguards your on-site operation 

 Infinite device cascading, synchronized by Genlock 

 EDID lock, ensuring no jump of connector resolution and display sequence 

 Intelligent thermal solution 

 Running status indication and fault alarm on front panel display 

 High quality XLR audio inputs and outputs 

 Central control via TCP/UDP protocol 

 4U rack mountable chassis 

 Industrial ruggedized design 

Configuration 

 HDMI 1.4 monitoring connector dedicated for software UI 

 Dual SSD built-in with dual OS 

 Dual authorization: dongle + license 

Interactive UI 

 Fully-visualized and friendly graphical UI, what you see is what you get 

 Customizable graphical UI layout 

 UI lock for safer unattended operation 

Power Performance 

Capability 
 Smooth playback of 1x 8K4K@60fps video, 4x 4K2K@60fps /6x 

4K2K@30fps videos, or 15x 2K1K@30fps videos 

 Unlimited layers 

Outputs 
 8192×1080@60Hz/4096×2160@60Hz or 2048×1152@60Hz 

output card 

 6x 4K or 24x 2K outputs 

 4:4:4 10-bit color sampling 

 Genlock and frame sync card 

Inputs 
 1920×1200@60Hz or 4096×2160@30Hz input card 

 4x 2K or 4x 4K inputs 

 NDI, streaming media and web page inputs 

Audio 
 XLR audio: 1x AUDIO IN, 1x AUDIO OUT L, 1x AUDIO OUT R 

 1x 3.5 mm audio input, 1x 3.5 mm audio output 

 Formats: mp3, aac, flac, amr, ape, wav, wma, ogg 

Control 
 Built-in Pilot MS3 Professional Multimedia Playback Software 

 Central control via TCP/UDP protocol 

 1x HDMI 1.3 connector for software UI 

 2x USB on front panel, 4x USB on rear panel 
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3.3 Appearance 

3.3.1 Front Panel 

 

No. Name Function 

1 Power button Press the button to power on or power off the device. 

 Note 

DO NOT unplug the power cord to power off the device. 

2 Display screen Display the device working, input and output statuses. 

3 USB ports 2x USB 3.0 

 Connect to the mouse and keyboard. 

 Insert the USB drive to import media files. 

3.3.2 Rear Panel 

 

 Notes 

 All product pictures shown in this document are for illustration purposes only. 
Actual product may vary. 

 The sync connectors may not be present for different device configurations. 

 The input and output cards do not support the hot swappable function. 
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Area Connector Qty Description 

CONTROL USB 4 4x USB 3.0 

 Connect to the mouse and keyboard. 

 Insert the USB drive to import media files. 

Ethernet 
ports 

2 Connect to the network. 

 1x Gigabit Ethernet port 

 1x 10G Ethernet port (reserved) 

CONTROL 
UI 

HDMI 1 1x HDMI 1.3 

Connect a monitor to display the user interface 
of the Pilot MS3 multimedia playback software. 

AUDIO Audio 
connectors 

5  XLR audio connectors 

− 1x AUDIO IN: Mic audio input connector 

− 1x AUDIO OUT-L: Audio output connector 
(left channel) 

− 1x AUDIO OUT-R: Audio output connector 
(right channel) 

 3.5 mm audio connectors 

− 1x input 

− 1x output 

 Note 

The audio device connected to the XLR audio 
input connector must have an independent 
power supply. 

SYNC Sync 
connectors 

2 Synchronize the mosaic images on multiple 
displays. 

GENLOCK 2 Synchronize the connected device units. 

I/1~I/2 Input card 
slots 

2 Please refer to the table in 3.3.3  Cards to select 
the desired input cards. 

O/3~O/8 Output card 
slots 

6 Please refer to the table in 3.3.3  Cards to select 
the desired output cards. 

Hardware/Software Performance 

Power supply 750 W  

CPU 11th Generation Intel® Core™ Processor 

Memory 64 GB DDR4 

Motherboard High-performance ASUS Server Motherboard 

Storage  System disk: Samsung M.2 SSD 250GB  

 Storage disk: Samsung M.2 SSD 1TB 

Graphics card NVIDIA RTX A4000  
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Sync card Quadro Sync II 

OS Windows 10 IoT Enterprise LTSC 

3.3.3 Cards 

The X400 provides the following input and output cards for your applications.  

Input Card 

4K Input Card 

 

2x HDMI 1.4 

 Downwards compatible with HDMI 1.3 

 Max. resolution of single connector: 4096×2160@30Hz 

 2x 4096×2160@30Hz inputs simultaneously 

 HDCP 2.2 compliant 

2K Input Card 

 
 1x DVI 

− Max. resolution: 1920×1200@60Hz, min. resolution: 
800×600@60Hz 

− Interlaced signal inputs supported 

 1x 3G-SDI 

− Downwards compatible with HD-SDI and SD-SDI 

− ST-424 (3G), ST-292 (HD) and SMPTE 259 (SD) standard 
video inputs  

− Max. resolution: 1920×1080@60Hz 

− Interlaced signal inputs supported 

− DOES NOT support input resolution and bit depth settings. 

Output Card 

4K Output Card 

 
 1x HDMI 2.0 

 1x DP 1.2 

− HDMI 2.0 and DP 1.2 output the same content. 

− Max. output resolution: 
8192×1080@60Hz/4096×2160@60Hz 

− HDCP 2.2 compliant 

− Mosaic output of multiple same-type connectors 

2K Output Card 

 

4x HDMI1.3  
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 Max. output resolution of single connector: 2048×1152@60Hz  

 Max. width: 2560 pixels (2560×972@60Hz) 

 Max. height: 2560 pixels (884×2560@60Hz) 

 4x HDMI mosaic outputs (2x2) by default  
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4 Applications 

About This Chapter 

This chapter is designed to introduce you to the X400 application scenarios. 

Overview 

 Applications - Single Unit  

 Applications - Dual Redundant 
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4.1 Applications - Single Unit 
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4.2 Applications - Dual Redundant 

 

 Note 

If the dual redundant application is required, please select the device configuration 
with sync connectors.  
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5 X400 Settings 

5.1 Set Main Display 

 Right click on your desktop and select Display settings. 

 Display settings 

 

 Select a display to set it as the main display. 

 Multiple displays-1 

 

 Note 

When multiple displays are connected, you can click Identify to show the number at 
the bottom left corner on each display.  
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 For the Multiple displays item, select Extend these displays. 

 Multiple displays-2 

 

 On the window that appears, select Keep changes. 

 Confirmation 

 

 Check the box next to Make this my main display. 

5.2 Change Resolutions 

5.2.1 Set Standard Resolutions 

 Right click on your desktop and select Display settings. 

 Display settings 

 

 Select a display to set it as the main display. 
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 Multiple displays-1 

 

 Note 

When multiple displays are connected, you can click Identify to show the number at 
the bottom left corner on each display.  

 For the Display resolution item, select the desired output resolution. 

 Multiple displays-2 

 

 On the window that appears, select Keep changes. 

 Confirmation 

 

 Repeat Step 2 to Step 4 to complete the resolution settings for other displays. 
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5.2.2 Set Custom Resolutions 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Display > Change resolution. 

 Change resolutions 

 

 Select the desired display. 

 Click Customize to show the customize window. 
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 Custom resolution-1 

 

 Click Create Custom Resolution. 

 Read the disclaimer information carefully and click Accept to show the Create 
Custom Resolution window. 

 Select the desired display. 

 Custom resolution-2 

 

 Set the horizontal pixels, vertical lines, refresh rate and scan type. 



X400 Professional Media Server User Manual 5 X400 Settings 

 

www.pixelhue.com 27 
 

 Click Test and then click Yes on the window that appears. 

 Confirmation 

 

 Custom resolution-3 

 

 Click OK to complete the custom resolution settings. 

After a custom resolution is created successfully, it will appear in the custom area as 
shown in the figure below. 

 Custom resolution-4 
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5.3 EDID Management 

After the display resolution settings, you need to manage the EDID for precise 
identification of display properties and to avoid the on-site screen display disorder. 

Load EDID  

The procedure of how to load the EDID is as follows. 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Workstation > View system topology. 

 NVIDIA control panel 

 

 Click EDID (Monitor) next to a desired output connector of the current graphics card 
to show the EDID management window. 
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 EDID (Monitor) 

 

 Manage EDID  

 

 Click Export EDID and then name the exported EDID file in the window that appears. 

 Select the Load tab to show the EDID loading window. 

 Click Browse and then select the EDID file exported in Step 4. 

 In the Select Connector to force EDID area, select the desired connector. 
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 Load EDID 

 

 Click Load EDID. 

 On the dialog box that appears, click OK to complete loading the EDID. 

 EDID loaded successfully 

 

 Go back to Workstation > View system topology to check the EDID status. If the 
original EDID (Monitor) changes to EDID (File), the EDID is loaded successfully.  

 EDID loaded successfully 
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Unload EDID  

The procedure of how to unload the EDID is as follows. 

 On the NVIDIA Control Panel interface, go to Workstation > View system topology. 

 Click EDID (File) to show the EDID management window. 

 EDID (File) 

 

 Select the Unload tab and then select the desired connectors. 

 Unload EDID 

 

 Click Unload EDID. 

 After the EDID is unloaded successfully, click OK on the dialog box that appears. 
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 EDID unloaded successfully 

 

 Go back to Workstation > View system topology to check the EDID status. If the EDID 
(File) changes to EDID (Monitor), the EDID is unloaded successfully.  

5.4 Output Mosaic 

The graphics card supports connector mosaic output. The output connector mosaic 
must observe the following rules. 

 The graphics card does not support irregular mosaic layouts. The mosaic layout 
must be 1×2, 1×3, 1×4, 2×2, 2×1, 3×1 or 4×1. 

 The output resolutions of the graphics card connectors that are used for mosaic 
must be the same. 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Workstation > Set up Mosaic. 

 Set up mosaic 
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 Click Create new configuration to show the mosaic settings window. 

 Mosaic settings 

 

 Select the screen number from the drop-down list of Number of displays. 

 Select the screen mosaic layout from the drop-down list of Topology (rows x 
columns). 

 Select the screen orientation from the drop-down list of Orientation of displays. 

 Click Next to proceed. 

 Select displays 

 

 Select the connected displays and then select their refresh rate and resolution. 

 Click Next to proceed. 
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 Arrange displays 

 

 Arrange the displays according to the screen arrangement and structure by dragging 
the available displays to the corresponding topology areas. 

 Arrange displays 

 

 Click Apply and then click Yes on the confirmation window. 

 Click Next to proceed. 
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 Adjust overlap and bezel correction 

 

You can perform overlapping adjustment or bezel correction to the vertical or 
horizontal edges of the display as needed.  

 Select whether to use the same settings for all the vertical or horizontal edges of 
the display in the Select how overlap/bezel correction is applied area. 

 Select the desired edges and then enter the overlap or bezel correction values for 
the selected edges. Click Apply after the settings are done. 

 Click Finish to complete the mosaic settings. 

 Mosaic completed 
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6 Software Overview 

About This Chapter 

This chapter introduces you to the user interface of the built-in multimedia playback 
software Pilot MS3.  

Overview 

 Introduction 

 Change UI Layout 

 Load Layout 

 Lock User Interface 
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 Note  

The software pictures and descriptions in this manual are based on Pilot MS3 V3.0.0, 
which may vary with the actual product in your hand. For the latest software 
operation instructions, please visit our official website or contact the technical 
support to obtain the latest user manual.  

6.1 Introduction 

After the software is started successfully, the main user interface is shown in 0. The 
functions of each area are described in Table 6-1. User interface 

 

Table 6-1 User interface descriptions 

Area Item Description 

Menu bar File Project file operations include: 

 New: Create a new project. 

 Open: Open a saved project. 

 Save: Save the current project. 

 Save As: Save the current project as a new 
project. 

 Package Project: Package the current project and 
the media files in it as an independent project file 
for easy use in future. 
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Area Item Description 

Resource Manage the media files and input sources. 

 Add Local Media: Add the local media files. 

 Add Input Source: Add the network media, NDI 
screens and websites as input sources. 

 Delete All Media: Delete all the imported media 
files. 

 Delete All Inputs: Delete all the added input 
sources. 

Output Manage the screens and slices. 

Window Show or hide the areas of the Pilot MS3 user 
interface. The area options include Media Library, 
Editing Area, Output, Preview, Fade to Black and 
Plan. 

Link  Disconnect Primary: When a backup device is 
added, use this function to disconnect the binding 
relation between the primary and backup devices.  

 Synchronize Data: Manually synchronize the data 
on the primary and backup devices, and the data 
on the master and slave devices. 

Settings Perform the system settings, authorization and 
hotkey bindings. 

Help  View the user manual. 

 View the product-related information. 

 Check for the software updates. 

 Get the contact of the product provider. 

语言

/Language 

Switch the UI language. 

Preview area  Output: View the content of the current output program. 

 Preview: Preview the content of the next program. 

− Cut: Send the currently previewed program to the screen 
without transition effect. 

− Take: Send the currently previewed program to the screen 
with the fade transition effect. 

− If Keep is selected and the program is sent to the screen 
via Take or Cut, the program will be played from the current 
playback progress in the preview area. 

− If Keep is not selected and the program is sent to the 
screen via Take or Cut, the program will be played from the 
beginning. 
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Area Item Description 

Editing area  Use layers to configure the output according to the on-site 
screen pattern. 

 Preview the output image. 

 : Adjust the output image brightness. The value ranges from 
–50 to + 50 and defaults to 0. 

 : Adjust the output volume. The value ranges from 0 to 100 

and defaults to 50. Click  to turn off the output audio. 

 : After selecting a layer or slice in the editing area, click this 
icon to capture the current frame of the selected layer or slice 
and add the captured image to the media library. 

 : Make the selected layer fill the screen area loaded by the 
output connectors where the layer is located and crosses. 

 : When the output image is moved out of the visible area, 
click this icon to restore the screen to the origin. 

 : Zoom in the editing area. 

 : Zoom out the editing area. 

Layer and 
program editing 
area 

 Add, control and mosaic the layers. 

 Edit, group and play the layers. 

Playback 
control area 

Control the playback of the programs or layers in the program. 

Media library 
and properties 
area 

Media 
Library 

Manage the media files. 

 Add the local media files. 

 Create folders to manage the media files 
efficiently. 

 Delete, replace or rename the media file. 

Input 
Sources 

Manage the input sources. 

 Add the network media, NDI screens and 
websites as input sources. 

 Delete the input sources. 

 Preview the input sources. 

Properties Edit the layer or program properties. 

Others  U3 Enable or disable the U3 control. 

 The output connection has been established. Click the 
button to disconnect the output. 

 The output has been disconnected. Click the button to 
regain the connection. 
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Area Item Description 

 Enable or disable the fade to black (FTB) function. 

When the slider block is at the leftmost, the output is 
black; when the slider block is at the rightmost, the 
output is normal. 

The default FTB duration is 0.5s and the value ranges 
from 0 to 5s. 

6.2 Change UI Layout 

Pilot MS3 allows you to adjust the user interface layout according to your using 
habits. You can save and load the adjusted layout. 

Click  at the top right corner of the target area to unlock this area. 

The icon descriptions are as follows: 

  (highlighted): The area is locked and you cannot adjust its size and position.  

  (grayed out): The area is unlocked. Move the cursor to the edge of the area 
and then click and drag the edge to adjust its size.   

 Move the cursor to any edge of an area. When the cursor turns into a double-sided 
arrow, click and drag the mouse to change the area size. 

 Move the cursor to the title bar of an area, and click and drag the mouse to change 
the area position. 

 Click  at the top right of the user interface to save the adjusted layout. 

 Save layout 

 

 Enter a layout name. 

The layout name is unique and it is recommended you set a name that is easy to 
recognize. 

 Click Save to save the layout. 
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6.3 Load Layout 

When the interface layout has been adjusted by others, you can load your preferred 
layout simply by using this function, instead of adjusting it area by area. 

 Click  at the top right of the user interface to open the layout loading window. 

 Load layout 

 

 Select the desired layout from the list on the left. 

 Click Load to load the layout. 

You can also perform the following operations: 

 Delete: Delete the selected layout from the layout list. 

 Restore Default: Restore the current interface layout to the default style. 

 Cancel: Cancel the layout loading and exit the layout loading interface. 

6.4 Lock User Interface 

If you do not want others to operate the software when you are away, just simply use 
this function to lock the software interface. 

 Click  at the top right of the user interface to open the UI locking window. 

 Lock user interface 

 

 Enter a password. 

 Set the opacity for the locking interface. 
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100% is completely opaque. At this time, the editing interface is completely invisible 
and only the lock screen background can be seen. 

 [Optional] Click Change next to Background to select a picture to be displayed on the 
locking interface. 

 Click Lock to complete the locking settings and lock the interface. 

 Notes  

 The locking password and background are for one-time use only. When you want 
to lock the interface for a second time, please set the password and background 
again. 

 To unlock the user interface, just enter your password click  to show the 
Pilot MS3 interface. 
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7 Project Operations 

About This Chapter 

This chapter guides you on how to add media files, edit programs, set program 
playback sequence and media properties, save configuration data as an independent 
project file for future use and more.  

Overview 

 Create New Projects 

 Manage Media 

 Manage Layers 

 Build Application Environment 

 Produce Programs 

 Playback Control  

 Save Projects 
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7.1 Create New Projects 

There are three methods provided for you to create a new project. 

 After Pilot MS3 is started successfully, click New on the startup interface and 
select the save path for the new project, and finally click Save. The system will 
automatically create a project file. 

 Go to File > New, select the save path for the new project and click Save to 
create a new project. 

 Click  below the menu bar to create a new project. 

7.2 Manage Media 

Pilot MS3 supports pictures, videos, audio media files and website inputs. 

The supported media formats are as follows: 

 Video: avi, asf, wmv, flv, mkv, mov, 3g, mp4, mpg, mpeg, ts, m4v 

 Picture: jpg, bmp, gif, mif, miff, png, wmf, jpeg, ico, pic 

 Audio: wav, mp3, wma, ape, aac, flac, ogg, dts, amr, alac 

 Office files: ppt, pptx 

 Notes  

Recommended video coding formats: 

 4K ＜ resolutions ≤ 8K: H.265 (HEVC) or VP9 recommended 

 Resolutions ≤ 4K: H.264 (AVC) recommended 
 

For a better image quality experience, the following video bitrates are recommended. 

Recommended video bitrates for SDR uploads: 

Type Video Bitrate Standard Frame Rate 

(24 fps, 25 fps, 30 fps) 

Video Bitrate High Frame Rate  

(48 fps, 50 fps, 60 fps)  

4320 (8K) 75 to 90 Mbps 110 to 135 Mbps 

2160p (4K) 35 to 45 Mbps 53 to 68 Mbps 

1440p (2K) 16 Mbps 24 Mbps 

1080p 8 Mbps 12 Mbps 

7.2.1 Add Media 

Pilot MS3 supports both single media file importing and batch importing. 

7.2.1.2 Import Files 

 Click the Media Library tab on the right pane of the user interface. 
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 Right click the blank area in the Media Library area and select Add Local Media to 
open a local folder. 

 Select the target media files and click Open. Pilot MS3 will import the selected files 
to the media library automatically. 

 Importing a single file: Select the desired file and click Open to complete the 
importing. 

 Importing multiple files: Press the Shift/Ctrl key, select the desired files, and 
click Open to complete the importing. 

7.2.1.3 Import Folders 

There are three methods provided for you to import a folder. 

 Import folder 

 Right click the blank area in the Media Library area and select Add Local Folder to 
open a local folder. 

 Select the desired folder where the media files are stored, and click Open. 

The system will automatically import the media files in the target folder with their 
original names to the media library. 

 Replace folder 

Right click the blank area in the Media Library area and select Add Folder. The system 
will automatically create a new folder. 

 Right click the folder and select Replace in the context menu. 

 Select the desired folder from the displayed dialog box. 

 Click Select Folder and the system will automatically import the media files in the 
target folder with their original names to the media library. 

7.2.2 Edit Media 

7.2.2.4 Media Optimization 

When the imported media or video resolutions are inconsistent, or the imported 
media resolution exceeds the processing capability of Pilot MS3, to facilitate future 
use, you can change the file resolution in advance by using this function. 

 Note  

Only the videos and .jpg pictures can be optimized to even resolutions only.  

 Select the picture or video that needs to be optimized from Media Library. 

 Right click the file and select Media Optimization in the context menu. 

 Set the desired parameters for the optimization. 
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 Media optimization 

 

If Lock Aspect Ratio is selected, you only need to set either width or height, and the 
other parameter value will be calculated automatically according to the current 
aspect ratio of the media. 

 Click Optimize and the system will automatically optimize the selected media file. 

7.2.2.5 Create Playback Collection 

The playback collection allows you to sort and combine multiple videos or pictures 
into a new collection source. All the videos and pictures in the collection will be 
played automatically according to the set mode. 

 Right click the blank area in the Media Library area and select Create Collection to 
open the Create Collection window. 

 Playback collection 
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 Select the desired media files in the All Media area on the left side. 

 Click  at the top right in the All Media area to add the selected files to the 
Collection Media area on the right side. 

 Select the newly-added media in the Collection Media area. 

 Change the media properties at the bottom. 

Table 7-1 Collection media properties 

Property Description 

Duration Set how long the selected media will be played. After the playback 
ends, the next media will be played automatically. 

If the duration is not set, the video file will be played according to its 
original playback duration, and the picture file will be played for 10 
minutes by default. 

Times Set how many times the selected media will be played. 

Playback Set the media playing order in the collection media. 

 Sequential: The media in the collection will be played in 
sequence. 

 Shuffle: The media in the collection will be played randomly. 

Switching Set the transition effect when the current media starts to play or 
stops the playing. Currently, only Cut and Fade effects are 
supported. 

Fade in Set the time length from when the current media starts to play to 
when the media is fully displayed. 

Fade out  Set the time length from when the current media starts to stop to 
when the media is stopped. 

 Repeat the above steps to complete the settings of other media in the collection. 

 Click OK to complete the collection settings. 

 Double click the collection name, and the name becomes editable. Rename the 
collection and press Enter to confirm the change. 

 Note  

After a collection is created, the default name is Playback Collection. It is 
recommended you give it a new name that is easier for you to distinguish.  

7.2.2.6 Media File Group Management 

You can create folders to classify the added media files. 

 Right click the blank area in the Media Library area and select Add Folder. The 
system will automatically create a new folder. 

 (Optional) Double click the folder to rename it. 

 Select the desired media files and drag them to the new folder. 
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 Notes  

 Hold down the Shift or Ctrl key, and select the target file or multiple files in Media 
Library. 

 After selecting a media file, right click it and select Insert Folder in the context 
menu to move the selected file to the newly-inserted folder. 

 

7.2.2.7 Media File Context Menu 

Right click a media to show the media file context menu. 

 Media file context menu 

 

 Add Local Media: Add new media files into the media library. 

 Media Optimization: Change the coding, quality, code rate, frame rate, audio and 
resolution settings of the videos or pictures. 

Only the videos and .jpg pictures can be optimized to even resolutions only. 

 Create Collection: Create a collection media. 

 Change Playback Collection: Change the settings of the collection media. 

 Add Local Folder: Import a folder containing media files into the media library. 

 Insert Folder: Create a new folder and move the selected media files into the 
folder. 

 Rename: Rename the selected media or collection. 

 Replace Media: Replace the currently-selected media. When the media is 
replaced, the media in the program will also be replaced synchronously. 

 Access File Location: Open the storage location of the current media. 

 Delete: Delete the current media. 

 Properties: View the media properties, such as the name, size, format and more. 

7.2.3 Add Input Sources 

You can add the network media, website input sources, NDI input sources and input 
sources from acquisition devices. The system automatically identifies and adds the 
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input sources from acquisition devices. You can also enable or disable the 
acquisition device. 

 Note  

When the acquisition card and its driver have been installed into the device 
successfully, Pilot MS3 will automatically identify and add the acquisition card input 
source.  

7.2.3.8 Add Network Media 

Pilot MS3 supports adding the streaming media whose format is rtsp and rtmp as 
input sources. 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add Network Media. The 
system will automatically open the network media adding window. 

 Add network media 

 

 Enter the media path in the URL text box. 

Make sure the media path begins with rtsp:// or rtmp://. 

 Click OK to complete the adding. 

7.2.3.9 Add Website Input Sources 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add Webpage. The website 
page will appear as shown below. 
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 Add website input sources-1 

 

 Enter an URL in the address bar. 

 Press Enter to enter the website and select the content to be played. 

  Click the drop-down arrow at the top right to show the list where you can set the 
webpage resolution. 

 Click ×  at the top right to close and finish adding the website. 

 Note  

When multiple tabs are opened, the input source displays the tab you stay on before 
closing.  

 Add website input sources-2 

 

 1: Preview window where you can preview the input source image, input source 
name, type and resolution 

 2: List all the input sources with their names. 

− : The added network media 

− : The added NDI input source 

− : The input sources from the acquisition device 

− : The added webpage input source 
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7.2.3.10 Add NDI Input Sources 

After Pilot MS3 is successfully installed, the NDI configuration tool NDI Sender that 
comes with Pilot MS3 will be installed. After NDI Sender is enabled, Pilot MS3 will 
automatically search for all the computers whose NDI sending functions have been 
enabled in the current network segment. 

Prerequisites 

 The computer running the NDI Sender and Pilot MS3 must be on the same 
network segment. 

 Make sure the computer running the NDI Sender and Pilot MS3 can 
communicate normally. 

NDI Settings 

 Double click the NDI Sender shortcut on the desktop to open the NDI Sender 
software. 

 NDI Sender 

 

 Set the image position and size for NDI on the computer screen. 

There are two methods to set the NDI image position and size. 

 Click Select ROI and then click and drag the mouse to select the display area you 
want to send. 

 In the Sent ROI area, you can precisely set the position and size of the sent area. 

− x: The horizontal offset from the top left corner of the sent area to the 
screen's left edge 

− y: The horizontal offset from the top left corner of the sent area to the 
screen's top edge 

− w: The horizontal width of the sent area 

− h: The vertical height of the sent area 

After the settings, you can click Show ROI to see the image position and image size 
you have set. 

 Enter an NDI name. 

 Select the screen you want to send if there are multiple computer screens. 

 Enter the frame rate of the NDI image. The default value is 25. 
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 Click Start to complete the NDI Sender settings. 

Add NDI Input Sources 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add NDI Screen. The system 
will automatically search the current network segment for all the NDI-enabled 
devices and then show you the NDI list. 

 NDI list 

 

 Select the NDI sources from the NDI list. 

 Select NDI sources 

 

 Enter an NDI name. 

After the name is changed here, the new name will be displayed under the Input 
Sources tab. 

 Click OK to complete adding an NDI source. 

Website Input Source Menu 

Right click an input source under the Input Sources tab to show the website input 
source menu. 
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 Website input source menu 

 

 Add Input Source: Add the network media, NDI screen or webpage. 

 Rename: Change the input source name. 

 Set Loop Interval: Set how long the input source is previewed in the preview area. 

 Stop Loop Preview: Stop loop preview of the current input source in the preview 
area. 

 Restore Loop Preview: Perform loop preview of all the input sources in the 
preview area. 

 Delete: Delete the current input source. 

 Properties: View the relevant information of the input source, including the name, 
type, network address, resolution and frame rate. 

 Click  at the bottom right of the acquisition card to select whether to add 
the sources from the acquisition device.   

7.3 Manage Layers 

7.3.1 Add Layers 

The layer is a container where you store the media file of a program. Before you edit 
the program, please add the layers and add the media files into the layers first. 

 Click + at the top left in the Plan area to add a layer. 

The new layer will be added to each program. 

 Change the layer position in the Editing Area to arrange the output slices and avoid 
overlapping perfectly. 
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 Slice position 

 

 Select a layer and click the Properties tab on the right pane to show the layer 
properties. 

 Configure the layer-related properties. 

 Notes  

 When you click and drag the layer, the purple auxiliary lines appear to help you 
better align the layers. 

 When there are too many media items, you can search for the media item in the 
search box above. 

 

7.3.2 Layer Mosaic  

Applications 

When an image needs to be output by multiple connectors and pixel-to-pixel display 
is required, you can use this function to satisfy your needs. 

 Layer mosaic effect 

 

Operating Procedure 

 Click  at the top left in the Plan area to open the layer mosaic window. 
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 Layer mosaic-1 

 

 Select and drag the layers in the Layer Layout area to the Layer Mosaic Layout area. 

 Layer mosaic-2 

 

 Arrange the layers in the way you prefer in the Layer Mosaic Layout area. 
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 Layer mosaic layout 

 

 (Optional) Change the mosaic layer name in the Properties area on the right. 

 Click Save to complete the layer mosaic. 

After the mosaic is completed, a new mosaic layer will be displayed in the Plan area. 

7.3.3 Set Layer Properties 

Layer Menu 

Right click a layer in the Plan area to show the layer menu as shown below. 

 Layer menu 

 

 Rename: Change the layer name. 

 Close Image: Do not display the image of the current layer in all the programs. 

 Close Audio: Do not play the audio of the current layer in all the programs. 

 Lock layer: Lock the current layer in all the programs. After the layer is locked, 
the layer property changes will not take effect. 

 Forward/Backward: Adjust the order of the layer. 

 Insert Above: Insert a layer above the current layer row. 
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 Insert Below: Insert a layer below the current layer row. 

 Clear Layer: Clear the data in the current layer. 

 Delete Layer: Clear the layer data and delete the layer. 

Layer Properties 

 Select a layer in the Plan area or Editing Area. 

 Select the Properties tab on the right pane of the user interface. 

 Layer properties 

 

Table 7-2 Function descriptions 

Function Description 

Name View and change the layer name. 

Control Close Image: Do not display the image of the current layer, and only 
the audio is played. 

Size Change the layer size. 

 W: Set the layer size in the horizontal direction. 

 H: Set the layer size in the vertical direction. 

Volume Adjust the output volume of the current layer. The default value is 
100%. 

 Click  to turn off the audio. 

 Click  to reset the volume to default. 
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Flip Set the flipping mode of the output image. If H and V are not 
selected, the output image is displayed normally, without any 
flipping effect. 

 H: Flip the image horizontally. 

 V: Flip the image vertically. 

Filling Set how the image is displayed in the selected layer. 

 Fill: The image fills the whole layer. 

 Proportional: The image is scaled and displayed in the layer 
according to its original aspect ratio. 

Brightness Set the overall brightness of the layer image. The value range is 
0%–100%, and it defaults to 50%. 

Contrast Set the overall contrast of the layer image. The value range is 
0%–100%, and it defaults to 50%. 

Opacity Adjust the transparency of the output image. The value range is 
0% (totally transparent)–100% (opaque), and it defaults to 100%. 

Saturation Adjust the colorfulness of the output image. The value range is 
0%–100%, and it defaults to 50%. 

Hue Set the relative degree of how bright or dark the output image is. 
The value range is 0%–100%, and it defaults to 50%. 

Insert Above Insert a layer below the current layer row. 

Insert Below Insert a layer below the current layer row. 

Delete Layer Clear the layer data and delete the layer. 

Clear Layer Clear the data in the current layer. 

7.4 Build Application Environment 

In Pilot MS3, you can use the screens and slices to build an application environment 
according to your actual on-site needs. 

 Screen: Configure the output image displayed on the screen. 

 Slice: Configure the image output by the corresponding output connector. 

Click Output in the menu bar to open the Output Management window where you can 
relate the screens with the output connectors and change the screen position and 
sequence. 
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 Output management 

 

7.4.2 Add Screens 

Each output connector on the discrete graphics card of the computer or server where 
Pilot MS3 is installed corresponds to a screen.  

To synchronize output images, please refer to 5 X400 Settings to complete relevant 
configurations. 

Add and Bind Screens Automatically 

Pilot MS3 will automatically detect the graphics card connectors and then complete 
the adding and binding of those detected connectors. All the connectors are 
displayed in the output list on the left. 

Add and Bind Screens Manually 

When you add the graphics card to the control PC or change the saved project file, 
you can add the screens manually. 

 Click Add Screen at the top left to add an output. 

 Set the screen position and size according to the screen layout in the Screen 
Properties area on the right. 
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 Screen management 

 

Table 7-3 Screen properties 

Menu Description 

Resolution The resolution of the screen loaded by the connectors 

Name Change the screen name. 

Binding Set the relationship between the output connector and screen. 

Position 
 X: Set the horizontal distance between the top left corner of the 

screen and the top left corner of the screen editing area. 

 Y: Set the vertical distance between the top left corner of the 
screen and the top left corner of the screen editing area. 

Size Set the screen size. 

 W: Set the screen size in the horizontal direction. 

 H: Set the screen size in the vertical direction. 

Layout When there are multiple screens, use this function to arrange the 
screens quickly. 

 : All the screens are arranged in a 1×4 pattern. 

 : The screens are arranged in a 2×2 pattern. 

 : All the screens are arranged in a 4×1 pattern. 

Enable Mark Display a sequence number on the output connector and screen, 
which helps you easily identify and adjust the output pattern. 

Disable Mark Do not display the sequence number. 
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Disconnect Do not show the output image of the current screen. 

Connect Show the output image of the current screen. 

 Click and drag the screens to complete the screen mosaic. 

7.4.3 Add Slices 

Pilot MS3 uses the slices to output the image to the LED screen. Select the desired 
image area of the layer using the slice, and then map the image to the output 
connector to complete the image construction. 

 Click Output in the menu bar to open the Output Management window. 

 Select the Slice tab. 

 Screen slice and area descriptions 

 

 Slice management: Add and delete slices. 

 Output slices: Adjust the output slice positions on the screen to construct the 
desired output image. 

 Layer slices: Adjust the sizes and positions of the layer slices, and flexibly crop 
the layer image. 

 Slice properties: Set the properties of the output slices, layer slices and layers. 

 : Slice self-adaptive configurations 

− In the layer slice area, click  to make the selected slice fill the layer. 

− In the output slice area, click  to make the selected slice fill the screen. 

 : Restore the canvas to the origin. 

 : Maximize the Output | Slice or Layer | Slice area. 

 Add the slices. 

 In the Layer List area, select the desired layer to add the slices. 



Pilot MS3 Professional Multimedia Playback Software 
User Manual 7 Project Operations 

 

www.pixelhue.com 62 
 

 Click + next to the layer name to add a slice. 

 Note  

You can also add the slices by simple copy and paste operations. Right click the 
desired slice in the Layer List area and then select Copy, and right click it again and 
then select Paste to add a slice.  

Application Example 

If you want to output only the watermelon area in Layer 4, do the following. 

 Slice application example 

 

Under the Slice tab, select Slice 4-1 on the left side. 

In the Layer | Slice area, move the slice to cover the tree and adjust the slice size as 
needed. 

In the Output | Slice area, adjust the output slice size as needed and move the slice to 
the desired screen. 

7.4.4 Set Slice Properties 

Output Slice 

The output slices are used for the construction of the output image. The output slice 
outputs the image of the corresponding layer slice, and then scales the layer slice 
image according to the output slice size you set. Select the desired output slice in the 
Output | Slice area, and then set the slice properties on the right. 
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 Output slice properties 

 

Table 7-4 Function descriptions 

Area Parameter Description 

Basic 
properties 

Name Display or change the name of the output slice. 

Position View or set the output slice position in the Output | 
Slice area. The origin of the Output | Slice area is 
the adjustment reference point and the adjustment 
unit is the pixel. 

 X: View or set the horizontal coordinate of the top 
left corner of the output slice in the Output | Slice 
area.  

 Y: View or set the vertical coordinate of the top left 
corner of the output slice in the Output | Slice area. 

Size View or set the output slice size. 

 W: View or set the output slice size in the horizontal 
direction. 

 H: View or set the output slice size in the vertical 
direction. 

 Click  between W and H to lock the slice aspect 
ratio. 

Ratio Set the aspect ratio of the output slice. 

Rotation Rotate the output image clockwise based on the 
center of the output slice. 
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Area Parameter Description 

Priority View or set the displaying priority of the output 
slice. 

 Display: Indicate the priority of the output slice by 
a number. The larger the number, the higher the 
priority, i.e., the more front the output slice is 
displayed. 

  Adjustment: Select the desired output slice, and 

then click , ,  or  to adjust its 
priority. 

Color 
properties 

Opacity Adjust the transparent degree of the output slice. 
The value ranges from 0% (totally transparent) to 
100% (nontransparent). 

R/G/B Adjust the RGB values of the output slice. 

 

Layers 

Select the desired layer in the Layer| Slice area, and then set the layer properties on 
the right. 

 Layer properties 

 

 Name: Display or change the name of the layer. 

 Position: View or set the layer position in the Layer | Slice area. The origin of the 
Layer | Slice area is the adjustment reference point and the adjustment unit is 
the pixel. 

− X: View or set the horizontal coordinate of the top left corner of the layer in 
the Layer | Slice area. 

− Y: View or set the vertical coordinate of the top left corner of the layer in the 
Layer | Slice area. 

 Size: View or set the layer size. 

− W: View or set the layer size in the horizontal direction. 

− H: View or set the layer size in the vertical direction. 

− Click  between W and H to lock the slice aspect ratio. If one of the two 
values is changed, the other value will change automatically according to 
the aspect ratio. 
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Layer Slices 

Select the desired layer slice in the Layer| Slice area, and then set the layer slice 
properties on the right. 

The layer slice is used to select a specific image area of the layer image. 

 Layer slice properties 

 

Table 7-5 Function descriptions 

Parameter Description 

Name Display or change the name of the layer slice. 

Position View or set the layer slice position upon the layer. The top left 
corner of the layer is the adjustment reference point and the 
adjustment unit is the pixel. 

 X: View or set the horizontal coordinate of the top left corner of the 
layer slice upon the layer.  

 Y: View or set the vertical coordinate of the top left corner of the 
layer slice upon the layer. 

Size View or set the layer slice size. 

 W: View or set the layer slice size in the horizontal direction. 

 H: View or set the layer slice size in the vertical direction. 

Ratio Set the aspect ratio of the layer slice. 

7.4.5 Configure Link Backup 

Pilot MS3 supports the device backup to set the backup relationship between two 
devices. You can set one of the devices as the primary device or the backup device. 
When the primary device has got a problem or the primary device's cable fails, the 
backup device will take over the responsibilities of the primary device seamlessly, 
and continue to work well to ensure the LED screen will not go black. 
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 Application 

 

Prerequisites 

 The primary and backup devices must be on the same network segment. 

 The primary and backup devices must be connected to the same downstream 
device, such as an F4 shown above. 

Operating Procedure 

 On the primary device, go to Link > Link Settings or click Output > Link to open the 
Output Management window. 
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 Link settings 

 

In the device list, the system will automatically search for all the online devices on the 
current network segment. 

Device status descriptions: 

 Name: 

− The media server name 

− : The device is online. 

− : The device is offline. 

 IP: 

− The device IP address 

− : The device is not used as a backup one. 

− : The device is used as a backup one 

 In the device list, select the device used as a backup one. 

 Select the desired device and drag it to the target primary device to complete the 
backup setting 
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 Backup settings 

 

Other Operations 

On the output management page, right click the backup device to show the context 
menu. 

 Context menu for backup device 

 

 Click Disconnect to disconnect the backup device from the primary device. Right 
click again and select Connect to reconnect them. 

 Click Remove to delete the backup device and remove the backup relation 
between the primary and backup devices. 

7.5 Produce Programs 

The playback unit of Pilot MS3 is the program.  
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After you have completed the construction of the outputs and added images to the 
layers, the system will output the image according to your construction (slices). 

7.5.1 Edit Programs 

The system provides 50 programs by default. Before the playback of a program, you 
must add the media files or input sources to the layers of the programs. 

Select the desired media file or input source in Media Library and drag it to the target 
program layer in the Plan area. 

 Edit programs 

 

 The functions of the icons in the Plan area are described as follows. 

: Return to the first program column. 

 : Locate the program that is being played or edited. 

 : Add a new program. 

 : Turn off the image display of the selected layer. 

 : Turn on the image display of the selected layer. 

 : Turn off the audio of the selected layer. 

 : Turn on the audio of the selected layer. 

7.5.2 Set Media Continuation 

When you want to play media content in the same layer of multiple continuous 
programs, you may need to add the same media file to each program. The added 
media will be played from the beginning when a new program starts, which may not 
be what you want to see. The cross-program media continuation function can 
perfectly solve this problem. After you have enabled this function for a specified 
media, the program will be played continuously but not played from the beginning 
when a new program is started. 

 Right click the desired media in the Plan area and select Cross-P Media Continuation 
from the context menu. 
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 Set media continuation 

 

 Click and drag the media to the target program. 

 Note  

Right click the desired media and select Cross-P Media Continuation, and then right 
click again the target program and select Complete Continuous Operations to 
complete the media continuation settings.  

7.5.3 Set Program Properties 

Program Menu 

Right click a program to show the context menu as shown in the following, and you 
can set the program properties as needed. 

 Set program properties 

 

 Play: Play the current program. 

 Map to Preview: Show the program content in the preview area. 

 Keep: After this is enabled, when the playback switches to the program, it starts 
to play from the last position. After this is disabled, when the playback switches 
to the program, it starts to play from the beginning. 
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 Rename: Change the program name. 

 Cut: Cut the current program. 

 Copy: Copy the current program and its properties. 

 Paste: Paste the copied program and its properties to the specified program. 

 Insert Before: Add a new program before the current program column.  

 Insert After: Add a new program after the current program column.  

 Delete Program: Clear all the layer data in the program and delete the program. 

Program Properties 

 Select a layer in the Plan area or Editing Area. 

 Select the Properties tab on the right pane of the user interface to show the program 
property settings. 

 Program properties 

 

 Name: View or change the program name. 

 Status: Display the playback status of the current program. 

 Keep: After this is enabled, when the playback switches to the program, it starts 
to play from the last position. After this is disabled, when the playback switches 
to the program, it starts to play from the beginning. 

 Switching: Set the transition effect for program switching. The options include 
Fade and Cut. 

 Fade In: When Fade is selected, set the duration for the current media to appear. 

 Fade Out: When Fade is selected, set the duration for the current media to 
disappear. 

 Brightness: Set the brightness of the images in the program. 

 Contrast: Set the contrast of the images in the program. 

 Add Before: Add a new program before the current program. 

 Add After: Add a new program after the current program. 

 Delete Program: Clear all the layer data in the program and delete the program. 
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Media Context Menu in Program 

Right click a media in a program in the Plan area to show the context menu. 

 Media context menu 

 

 Cross-P Media Continuation: When you want to play a media in the same layer of 
multiple continuous programs, you may need to add the same media file to each 
program. The added media will be played from the beginning when a new 
program starts, which may not be what you want to see. The cross-program 
media continuation function can perfectly solve this problem. After you have 
enabled this function for a specified media, the program will be played 
continuously but not played from the beginning when a new program is started. 

 Rename: Change the name of the media in the program. The media name in the 
media library is changed at the same time. 

 Jump: Set the jump playback mode of the current media after the media 
playback ends. 

− Loop: Loop the playback of the selected media in the program, and then 

 will be displayed at the top right of the layer in the Plan area. 

− EOF: The current media will stop the playing and display the last frame after 

being played once, and  will be displayed at the top right of the layer in 
the Plan area. 

− Stop: The playback will stop after being played once, and  will be 
displayed at the top right of the layer in the Plan area. 

− Next Program: Jump to the next program after the current media playback 
ends. 

− Jump to Specified Program: Specify the desired program and the specified 
program will be played automatically after the current program is 
completed. 

 Keep: After this is enabled, when the playback switches to the program, it starts 
to play from the last position. After this is disabled, when the playback switches 
to the program, it starts to play from the beginning. 

 Cut: Cut the media in the layer of the current program. 

 Copy: Copy the media in the layer of the current program. 

 Paste: Paste the copied or cut media. 
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 Copy Properties: Copy the properties of the selected media. 

 Paste Properties: Paste the copied media properties to another media. 

 Locate Media: Locate the current media file in the media library. 

 Delete Media: Delete the selected media. 

Program Media Properties 

 Select the desired media in a program. 

 Select the Properties tab on the right pane of the user interface to show the media 
property settings. 

 Media properties 
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Table 7-6 Media property descriptions 

Area Function Description 

Name View or change the media name. 

Time Duration View the length of the media playing time.  

Start Time 
Set the start time of the media playback. The start time 
value cannot be later than the media duration. 

End Time 
Set the end time of the media playback. The end time 
value is later than the start time, and cannot be later 
than the media duration. 

Play Play Set the playback mode of the current media during 
the playing time of the program. 

 Loop: Loop the playback of the selected media in 

the program, and then  will be displayed at the 
top right of the layer in the Plan area. 

 EOF: The current media will stop the playing and 
display the last frame after being played once, and 

 will be displayed at the top right of the layer in 
the Plan area. 

 Stop: The playback will stop after being played 

once, and  will be displayed at the top right of 
the layer in the Plan area. 

 Loop Times: Set the loop playback times of the 

current media, and  is displayed at the top right 
of the layer in the Plan area. ("N" stands for the 
number of loop times). 

Jump Set the jump playback mode of the current media 
after the media playback ends. 

 No Jump: No operation will be performed after the 
current media playback ends. 

 Next Program: Jump to the next program after the 

current media playback ends, and  will be 
displayed at the top right of the layer in the Plan 
area. 

 If you have enabled the program jump, the group 
name and program name of the next program are 

displayed and  will be displayed at the top right 
of the layer in the Plan area. 

Switching Set the transition effect for switching the current 
media in the program layer. The options include 
Fade and Cut. 
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Fade In When Fade is selected, set the duration for the 
current media to appear. 

Fade Out When Fade is selected, set the duration for the 
current media to disappear. 

Keep After this is enabled, when the playback switches to 
the program, it starts to play from the last position. 
After this is disabled, when the playback switches to 
the program, it starts to paly from the beginning. 

Speed Set fast playback speed for the media. 

Volume Adjust the output volume of the media. 

Click  on the right of the volume to turn off the 
output volume of the layer. 

Image Filling Set how the image is displayed in the selected layer. 

 Fill: The image fills the layer. 

 Proportional: The image is scaled and displayed in 
the layer according to its original aspect ratio. 

Flip Set the display mode of the output image. If H and V 
are not selected, the output image is displayed 
normally, without any flipping effect. 

 H: Flip the image horizontally. 

 V: Flip the image vertically. 

Brightness Set the overall brightness of the layer image. The 
value range is 0%–100%, and it defaults to 50%. 

Contrast Set the overall contrast of the layer image. The value 
range is 0%–100%, and it defaults to 50%. 

Opacity Set the transparency of the output image. The value 
range is 0% (totally transparent)–100% (opaque), 
and it defaults to 100%. 

Saturation Adjust the colorfulness of the output image. The 
value range is 0%–100%, and it defaults to 50%. 

Hue Set the relative degree of how bright or dark the 
output image is. The value range is 0%–100%, and it 
defaults to 50%. 
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Crop Crop 
 Cropping method: 

− Crop: Crop the output image. 

− Stretch: The media adapts to and fills the 
layer. 

 Percentage: 

− Selected: The unit for the cropping is the 
percentage. 

− Deselected: The unit for the cropping is the 
pixel. 

T: Set the size of the cropped area at the top part of 
the media. 

B: Set the size of the cropped area at the bottom part 
of the media. 

L: Set the size of the cropped area at the left part of 
the media. 

R: Set the size of the cropped area at the right part of 
the media. 

Keying 

 

Subtract the specified color and delete it from the 
selected media. 

Check the box next to Color Key to enable the 
function and delete the selected color. 

Four method of selecting the color to be deleted are 
available:  

 Click the eyedropper  and select the color to be 
deleted on the screen. 

 Click the color block and select the color in the 
displayed Select Color page. 

 Next to #, enter the value of the color to be deleted. 

 Double click the values next to RGB and enter their 
values, respectively, to precisely set the color. 
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Borders Configure the size and color of the image borders. 

Check the box next to Borders to enable the function. 

 Set the border color. Four methods are available: 

− Click the eyedropper  and select the 
desired color on the screen. 

− Click the color block and select the color in the 
displayed Select Color page. 

− Next to #, enter the value of the desired color. 

− Double click the values next to RGB and enter 
their values, respectively, to precisely set the 
color. 

− Click the A value and enter a value to set the 
border opacity. The value range is 0% (totally 
transparent)–100% (opaque). 

 Set the border size. Two methods are available.  

− Percent: Set the percentage of the border size 
to the media. 

− Pixels: Set how many pixels the border size 
occupies. 

7.5.4 Set Program Jump 

After the program editing is completed, set the program jump to realize the 
automatic continuous playback of the programs. 

Before the program jump settings, you need to specify a media in each program as 
the timing base. After the playback of the selected media ends, the specified 
program will start to play. 

 Select the desired media in a program in the Plan area and right click the media to 
open the context menu. 

 Go to Jump > Jump to Specified Program and all the programs become selectable. 

 Program jump 

 

 Select the desired program to complete the jump settings. 

If you want to jump to a program in another group, click the name of the group where 
the program belongs, and then click the program name to complete the program 
jump between program groups. 

 Repeat 错误!未找到引用源。 to 错误!未找到引用源。 to complete the jump 
settings for more programs. 
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After the program jump settings,  is displayed at the top right of the layer in the 
Plan area. 

 Note 

When two programs become jump partners for each other, they will be played 
circularly.  

7.5.5 Manage Program Groups 

When you need a large number of programs, you can create groups to manage those 
programs. Each group supports 20 programs by default. 

 Click + at the bottom left in the Plan area to add a program group. 

 Add program groups 

 

 Right click the group name and select Rename to give the group a new name. 

 Rename groups 

 

 Click + at the top right to add new programs to the newly-added group. 

7.6 Playback Control 
After the program editing, you can play the programs. 

 Program playback: Click  next to a program name in the Plan area to play 
the program. 

During the playback of a program, you can also switch the playback content of a 
layer. For example, in the below figure, when Program 1 is being played, double 
click the media in Layer 2 of Program 2 to switch the playback of the media.  
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 Playback control-1 

 

 Playback control: In the playback control area, control the playback of a single 
media or all the media. 

 Playback control-2 

 

− Click  or  to play and pause the playback of all media in a program. 

− Click  or  next to a media name to play or pause the playback of 
the selected media. 

− Click  at the top right, and the program media adopts the count up 
timer. 

− Click  at the top right, and the program media adopts the countdown 
timer. 

− Click  at the top right, click the name of the program to be played 
synchronously and drag the media playback progress bar to play two media 
synchronously. 

− Click  at the top left to set the fast-forward and rewind speed. The 
options include x2, x4, x8 and x16. (The number refers to the playback 
speed and the unit is second.) 

− Click  to set the fast-forward speed. 

− Click  to set the rewind speed. 

 In the Preview area, click Cut or Take to send the preview program to the screen. 

 Preview playback 
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− Cut: Send the currently previewed program to the screen without transition 
effect. 

− Take: Send the currently previewed program to the screen with the fade 
transition effect. 

− If Keep is selected and the program is sent to the screen via Take or Cut, the 
program will be played from the current playback progress in the preview 
area. If Keep is not selected and the program is sent to the screen via Take 
or Cut, the program will be played from the beginning. 

 FTB: 

Click  at the upper left of the main interface and the output image will fade to 
black within the time you set. 

The time ranges from 0 to 5s and it defaults to 1s. 

7.7 Save Projects 

You can save the editing and settings as an independent project file for easy use in 
the future. 

 Go to File > Save or Save As to save the current project file (*.pms3) to your 
local storage. 

 Click  at the top left of the main interface to create a new project. 

 Click  at the top left of the main interface to save the current project. 

 Click  at the top left of the main interface to save the current project as a 
new project file. 

 Click  at the top left of the main interface to package the current project, 
such as all the used media or all the media files and project files, which is 
convenient for future use. 
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8 Software Settings 

About This Chapter 

This chapter introduces you to various settings of the software. 

Overview 

 System Settings 

 Authorization 

 Hotkey Binding 

 MIDI Binding 
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8.1 System Settings 

Set the startup-related settings. Go to Settings > System Settings to open the 
System Settings window. 

8.1.1 General 

 System settings 

 

Basic 

 Start software after power on 

− Selected: Automatically launch Pilot MS3 when the system is started. 

− Deselected: Do not automatically launch Pilot MS3 when the system is 
started. 

 Start software and open recent project after power on 

− Selected: Automatically open the last edited project when Pilot MS3 is 
launched. 

− Deselected: Display the default interface when Pilot MS3 is launched. 

 Play project after opened 

− Selected: When you open a project, the project will be played from where it 
stopped playing last time. 

− Deselected: When you open a project, no media will be played and the 
project interface will be displayed. 

 Auto save project 

Set an interval that the system will automatically save the project. The value 
ranges from 1 to 30 min and it defaults to 5 min. 

Canvas 

Set the background color of the editing area. 

In the canvas settings area, change the background color of the editing area by 
selecting a preset color or customizing a color. 
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After the basic and canvas settings are done, click OK to apply the settings. 

8.1.2 Display 

 Display settings 

 

Coding and Decoding 

Configure the rendering graphics card of Pilot MS3. 

General 

 Fade In: Set the time length from when the current media starts to play to when 
the media is fully displayed. The value ranges from 0 to 10 s. When the value is 
set to 0 s, there is no transition effect. 

 Fade Out: Set the time length from when the current media starts to stop to 
when the media is stopped. The value ranges from 0 to 10 s. When the value is 
set to 0 s, there is no transition effect. 

 Apply to All: Apply the duration of Fade In and Fade Out to all the programs. 
After the time length is set, if you do not click Apply to All, the transition will only 
be effective on the programs without the added media. 

 MFPS: Real-time frame rate 

− Selected: Display the real-time frame rate at the bottom right on the media 
preview window. 

− Deselected: Do not display the real-time frame rate on the media preview 
window. 

After the coding and decoding and general settings are done, click OK to apply the 
settings. 

8.1.3 Audio 

On the system settings window, click Audio to enter the audio settings tab page. 



Pilot MS3 Professional Multimedia Playback Software 
User Manual 8 Software Settings 

 

www.pixelhue.com 84 
 

 Audio settings 

 

Select an audio output channel from the drop-down list next to Channel. Click OK to 
complete the audio settings. 

8.1.4 Office 

Pilot MS3 supports playback of PowerPoint files. Before playback, configure the 
basic information of PowerPoint files. 

On the system settings window, Click Office to enter the office settings tab page. 

 Office settings 

 

 PowerPoint Resolution: Set the resolution according to the resolution displayed 
on the PowerPoint file. 

 Slide Transition: Set the transition of each slide of the PowerPoint document 
during playback. 

− Animation Mode: Show the animations of slides during playback. 

− Picture Mode: Do not show the animations of slides. 
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 Use arrow keys to switch between slides 

− Selected: Allow arrow keys to be used to switch between slides. 

− Deselected: Arrow keys cannot be used to switch between slides. 

Click OK to complete the office settings. 

8.2 Authorization 

One authorization dongle corresponds to only one authorization file. When the dongle 
matches the authorization file, Pilot MS3 can be used normally. 

Pilot MS3 supports the centralized management of multiple authorization files. When 
an authorization dongle is inserted, the system can automatically identify the 
corresponding authorization file to ensure the normal operation of Pilot MS3. 

Import the authorization file. 

 Go to Settings > Authorization to open the authorization settings window. 

 Click Import at the bottom to open the authorization file importing window. 

 Select the desired authorization file and click Open. The system will 
automatically import the file to Pilot MS3. 

 Authorization file 

 

Check the authorization. 

 Insert the authorization dongle into the system. 

 The system will automatically identify the authorization file according to 
inserted the authorization dongle, and then display In Use after successful 
identification. 

8.3 Hotkey Binding 

Pilot MS3 supports custom hotkeys, and users can use those keys to operate Pilot 
MS3 simply and conveniently. Go to Settings > Hotkey Binding to show the hotkey 
settings interface, and the areas where you can enable the hotkey function are 
highlighted. 
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 Hotkey binding 

 

Click the target area, and then press the letter or number keys on the keyboard as 
needed to complete adding the hotkey. 

After the adding, go to Settings > Complete Binding to make the hotkeys take effect 
and exit the hotkey settings interface. 

 Note: 

The Ctrl+H key combination is a built-in global hotkey which can quickly locate the 
mouse to the center of the main interface. When you set other hotkeys, this 
combined one cannot be used.  

For example: 

Set the hotkey for Program 1 to Q. 

a. On the hotkey settings interface, click Program 1. 

b. Press the letter Q on the keyboard, and then a letter Q will be displayed on 
Program 1. 

 

8.4 MIDI Binding 

Bind the Pilot MS3 functions with the MIDI (Musical Instrument Digital Interface) 
keyboard. After a successful binding, you can control Pilot MS3 by using a MIDI 
keyboard. 
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8.4.1 Connect MIDI Keyboard 

Prerequisites 

 You have connected a MIDI keyboard to the computer where Pilot MS3 is 
installed. 

 Make sure the computer where Pilot MS3 is installed have successfully 
recognized the connected MIDI keyboard. 

Procedure 

Click MIDI at the top right of the user interface to open the MIDI connection settings 
window. 

 MIDI connection 

 

Pilot MS3 will automatically recognize all the connected MIDI keyboards. 

Select the desired MIDI keyboard from the MIDI List. 

Click Connect to complete the connection. 

8.4.2 Bind MIDI 

Go to Settings > MIDI Binding to show the MIDI binding page. You can see all the 
available functions that can be bound with a MIDI keyboard are highlighted. 
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 Available functions for MIDI binding 

 

Select the target function in Pilot MS3 and then press the desired key on the MIDI 
keyboard to complete the binding. 

After a successful binding, go to Settings > Complete MIDI Binding to make the 
binding take effect and exit the binding page. 
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9 Software Help Information 

About This Chapter 

This chapter introduces you the software-related and company-related information 
that may help you during the use. 

Overview 

 User Manual 

 About 

 Software Updates 

 Contact Us 
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9.1 User Manual 

Go to Help > User Manual on the menu bar to open and view the product user 
manual. 

9.2 About 

View the software version, license agreement and other information, and scan the QR 
code to get more information on our products or send us your feedback. 

9.3 Software Updates 

Check the current version of the software. When a new software version is detected, 
the system will download the latest version and then you can follow the instructions 
to complete the update. 

9.4 Contact Us 

View the contact information of the software provider and the software copyright and 
license agreement. 
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10 Software Tools 

About This Chapter 

To better meet onsite playback requirements, Pilot MS3 has integrated some tools 
that can be used to edit video files. 

Overview 

 Transcoding Assistant
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10.1 Transcoding Assistant 

Pilot MS3 supports the conversion of the video coding format, code rate, resolution, 
and frame rate to satisfy the requirements of different playback scenarios. 

 Go to Tools > Media Transcoding to open the transcoding assistant window. 

 Transcoding assistant 

 

 Click Add at the bottom to open the local folder where you can select the desired file. 

You can also add multiple files by pressing the Ctrl key and selecting the files 
simultaneously. 

 Click Add to add them into the assistant. 

 Select the target video file. 

 On the right side, set the parameters of Coding, Quality, Code Rate, Frame Rate, 
Resolution and Audio. 

 Coding: Set the coding format of the transcoded video. The supported options 
include Adaptive, h264, h265, VP9 and hap. When Self-Adaptive is selected, the 
video will be transcoded according to the original video coding. 

 Quality: Set the quality of the transcoded video. The supported options include 
Low, Medium and High. 

− High: Keep the quality of the transcoded video the same as the original 
video quality. 

− Low: The quality of the transcoded video is relatively blurred compared to 
the original video quality. 

− Medium: The quality of the transcoded video is between the high and low 
qualities. 

 Code Rate: Set the code rate of the transcoded video. The supported options 
include Self-Adaptive and Custom. 
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− Adaptive: The code rates before and after the transcoding are the same. 

− Custom: Set the desired code rate and the video will be transcoded 
according to the set value. 

 Frame Rate: Set the frame rate of the transcoded video. The supported options 
include Self-Adaptive, 24, 30, 60 and Custom. 

− Adaptive: The frame rates before and after the transcoding are the same. 

− 24/30/60: The frame rate after the transcoding will be 24 Hz, 30 Hz, and 60 
Hz, respectively. 

− Custom: Set the desired frame rate and the video will be transcoded 
according to the set value. 

 Resolution: Set the resolution of the transcoded video. 

− W: Set the horizontal size of the transcoded video. The value defaults to 
1920 and can reach a maximum value of 16384. 

− H: Set the vertical size of the transcoded video. The value defaults to 1080 
and can reach a maximum value of 16384. 

 Audio: Set how to deal with the audio that comes with the video. The supported 
options include Keep and Remove.  

− Keep: The transcoded video retains the audio in the video before 
transcoding. 

− Remove: The transcoded video display pure images without any audio. 

 Click Transcode and the system will automatically start the transcoding process. 

When the progress reaches 100% in the Progress column, the transcoding 
completes. After the transcoding, the video will be saved in the path specified in Save 
Path. 

 Click Open to open the local folder where you can view the transcoded files. 

 Click Change to change the save path. 

 Click Delete at the bottom to delete the selected video files.
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11 Specifications 

Electrical Specifications Power 
connector 

100–240V~, 10–5A, 47–63Hz 

Maximum 
power 
consumption 

650 W 

Operating Environment Temperature 0°C to 45°C 

Humidity 0% RH to 80% RH, non-condensing 

Storage Environment Temperature –10°C to +60°C 

Humidity 0% RH to 95% RH, non-condensing 

Physical Specifications Dimensions L 482.6 mm × P 694.7 mm × H 183.5 
mm 

W 19 inch × D 27.45 inch × H 7.2 inch 

Weight 23.5 kg / 51.8 lbs (Fully loaded without 
accessories) 

57.2 kg / 126.1 lbs (Fully loaded with 
accessories & flight case) 

Noise on Average  
(@1, 0.75m height) 

Front: 51.8 dB 

Rear: 54.1 dB 

Packing Information • 2x DP to DP cables 

• 3x HDMI to HDMI cables 

• 1x AC power cable 

• 1x Grounding cable 

• 1x Keyboard & mouse 

• 1x Windows product key 

• 1x USB to audio adapter 

• 1x Quick Start Guide 

• 1x Customer Letter 

• 1x Safety Manual 

• 1x Certificate of Approval 
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Certifications CE, EAC, PSE, FCC, RoHS, RCM 

 Note 

If the product does not have the relevant 
certifications required by the countries or regions 
where it is to be sold, please contact PIXELHUE to 
confirm or address the problem. Otherwise, the 
customer shall be responsible for the legal risks 
caused or PIXELHUE has the right to claim 
compensation. 
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